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1.​ Introduction 
Welcome to Animation BowCombat, a specialised animation pack designed for 
smooth integration across multiple platforms, delivering high-impact archery 
motion to your projects.  

Featuring meticulously crafted bow combat animations, this pack is primed to 
enhance your workflow and breathe life into any project’s combat needs. From 
epic battles to stealth shots, to agile slides and leaps, these versatile archery 
actions will bring characters to life with fluidity and personality.  

So nock your arrows and prepare your projects to meet the pointy end of 
animated bowmanship! 

 
From all of us at Synty, ​
We thank you for the support! 
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2.​ Installation and Setup  
Requirements 

Animation component files 

●​ Unity supports FBX imports across all current LTS versions 

Sample content 

●​ TextMesh Pro Unity package - in order to correctly see Gallery scene text 
labels 

●​ Timeline Unity package  
 

Unity Asset Store Installation 
If you purchased Animation BowCombat from the Unity Asset Store, you can 
download the latest package using the Unity Package Manager, as follows: 

1.​ Open Unity Package Manager from the top menu Window >  Package 
Manager 

2.​ Change the Packages drop down to My Assets 
3.​ Look for or search ‘Synty Animation BowCombat’ and click Install​

 

Synty Store Installation 
If you purchased Animation BowCombat from www.syntystore.com, you will 
need to do the following: 

1.​ Open your Project window (from top menu select Window > General > 
Project) 

2.​ Right Click in the Assets directory and select Import Package > Custom 
Package... from the right click menu 
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3.​ Navigate to where you downloaded the .unitypackage file and click ‘Open’ 
4.​ You will be presented with a window to import the package, click ‘Import’. 

 
 

3.​ Animation Pack Components 
The Animation Pack features 998 purpose-built animations. It has a 
comprehensive range of actions, including multiple stances, hits, deaths, leaps, 
rolls, and more. Each part of the archery process is broken down into individual 
actions, from equipping, aiming, drawing, firing, reloading, etc, allowing for 
maximum flexibility and control over your combat system.  
In addition, the pack includes rigged bow models, quivers, and arrows of varying 
styles, all designed to work seamlessly with the animations.  

Key features 

Animation formats 
●​ 499 total animations for each format: Polygon and Sidekick - the two key 

types of Synty characters.  

Animation Sets 
Within each character format (Sidekick and Polygon), there are: 

●​ 190 BowCombat character animations per format including RootMotion 
versions, with smooth blending and transitions 
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●​ 309 associated ‘Prop’ animations per format. This includes 103 animations 
for each of the different bow types (Longbow, Recurve Bow and 
Compound Bow) to synchronise bow animation with character animation 

Models: 
●​ 14 rigged bow models 
●​ 7 quiver models 
●​ 3 arrow models 
●​ 1 target model 

Humanoid Character Avatar: 
●​ These animations integrate with Unity's Mecanim system, providing a 

foundation for utilising animations across different characters easily. 

Gallery Scenes: 
●​ Two scenes (Sidekick and Polygon) showcasing the animations as 

separate assets for users to view clearly as individual animations. 
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List of Polygon Character Animations 

Feminine 
Death 
A_POLY_BOW_Death_Head_F_Femn.fbx 
A_POLY_BOW_Death_Head_L_Femn.fbx 
A_POLY_BOW_Death_Head_R_Femn.fbx 
A_POLY_BOW_Death_Spine_B_Femn.fbx 
A_POLY_BOW_Death_Stomach_F_Femn.fbx 
 
Hit 
A_POLY_BOW_Hit_Back_B_React_Femn.fbx 
A_POLY_BOW_Hit_Back_B_Stagger_Femn.fbx 
A_POLY_BOW_Hit_Back_B_Stagger_RM_Femn.fbx 
A_POLY_BOW_Hit_Head_B_React_Femn.fbx 
A_POLY_BOW_Hit_Head_B_Stagger_Femn.fbx 
A_POLY_BOW_Hit_Head_B_Stagger_RM_Femn.fbx 
A_POLY_BOW_Hit_Head_F_React_Femn.fbx 
A_POLY_BOW_Hit_Head_F_Stagger_Femn.fbx 
A_POLY_BOW_Hit_Head_F_Stagger_RM_Femn.fbx 
A_POLY_BOW_Hit_Head_L_React_Femn.fbx 
A_POLY_BOW_Hit_Head_L_Stagger_Femn.fbx 
A_POLY_BOW_Hit_Head_L_Stagger_RM_Femn.fbx 
A_POLY_BOW_Hit_Head_R_React_Femn.fbx 
A_POLY_BOW_Hit_Head_R_Stagger_Femn.fbx 
A_POLY_BOW_Hit_Head_R_Stagger_RM_Femn.fbx 
A_POLY_BOW_Hit_Shoulder_L_React_Femn.fbx 
A_POLY_BOW_Hit_Shoulder_L_Stagger_Femn.fbx 
A_POLY_BOW_Hit_Shoulder_L_Stagger_RM_Femn.fbx 
A_POLY_BOW_Hit_Shoulder_R_React_Femn.fbx 
A_POLY_BOW_Hit_Shoulder_R_Stagger_Femn.fbx 
A_POLY_BOW_Hit_Shoulder_R_Stagger_RM_Femn.fbx 
 
Idle 
A_POLY_BOW_Crouch_Idle_Base_Equip_ToBowDown_Femn.fbx 
A_POLY_BOW_Crouch_Idle_Base_Femn.fbx 
A_POLY_BOW_Crouch_Idle_Base_ToBowDown_Femn.fbx 
A_POLY_BOW_Crouch_Idle_Base_WithBow_Femn.fbx 
A_POLY_BOW_Stand_Idle_Base_Equip_ToBowDown_Femn.fbx 
A_POLY_BOW_Stand_Idle_Base_Femn.fbx 
A_POLY_BOW_Stand_Idle_Base_ToBowDown_Femn.fbx 
A_POLY_BOW_Stand_Idle_Base_ToTurned_Femn.fbx 
A_POLY_BOW_Stand_Idle_Base_WithBow_Femn.fbx 
A_POLY_BOW_Crouch_Idle_Base_Equip_ToBowDown_FPV_Femn.fbx 
A_POLY_BOW_Stand_Idle_Base_Equip_ToBowDown_FPV_Femn.fbx 
 

Masculine 
Death 
A_POLY_BOW_Death_Head_F_Masc.fbx 
A_POLY_BOW_Death_Head_L_Masc.fbx 
A_POLY_BOW_Death_Head_R_Masc.fbx 
A_POLY_BOW_Death_Spine_B_Masc.fbx 
A_POLY_BOW_Death_Stomach_F_Masc.fbx 
 
Hit 
A_POLY_BOW_Hit_Back_B_React_Masc.fbx 
A_POLY_BOW_Hit_Back_B_Stagger_Masc.fbx 
A_POLY_BOW_Hit_Back_B_Stagger_RM_Masc.fbx 
A_POLY_BOW_Hit_Head_B_React_Masc.fbx 
A_POLY_BOW_Hit_Head_B_Stagger_Masc.fbx 
A_POLY_BOW_Hit_Head_B_Stagger_RM_Masc.fbx 
A_POLY_BOW_Hit_Head_F_React_Masc.fbx 
A_POLY_BOW_Hit_Head_F_Stagger_Masc.fbx 
A_POLY_BOW_Hit_Head_F_Stagger_RM_Masc.fbx 
A_POLY_BOW_Hit_Head_L_React_Masc.fbx 
A_POLY_BOW_Hit_Head_L_Stagger_Masc.fbx 
A_POLY_BOW_Hit_Head_L_Stagger_RM_Masc.fbx 
A_POLY_BOW_Hit_Head_R_React_Masc.fbx 
A_POLY_BOW_Hit_Head_R_Stagger_Masc.fbx 
A_POLY_BOW_Hit_Head_R_Stagger_RM_Masc.fbx 
A_POLY_BOW_Hit_Shoulder_L_React_Masc.fbx 
A_POLY_BOW_Hit_Shoulder_L_Stagger_Masc.fbx 
A_POLY_BOW_Hit_Shoulder_L_Stagger_RM_Masc.fbx 

Neutral 

Crouch_Aim 
A_POLY_BOW_Crouch_Aiming_DrawnShaking_Neut.fbx 
A_POLY_BOW_Crouch_Aiming_Drawn_Neut.fbx 
A_POLY_BOW_Crouch_Aiming_Reload_Neut.fbx 
A_POLY_BOW_Crouch_Aiming_ToDrawn_Neut.fbx 
A_POLY_BOW_Crouch_Aiming_Undrawn_Neut.fbx 
A_POLY_BOW_Crouch_Aiming_DrawnShaking_FPV_Neut.fbx 
A_POLY_BOW_Crouch_Aiming_Drawn_FPV_Neut.fbx 
A_POLY_BOW_Crouch_Aiming_Reload_FPV_Neut.fbx 
A_POLY_BOW_Crouch_Aiming_ToDrawn_FPV_Neut.fbx 
A_POLY_BOW_Crouch_Aiming_Undrawn_FPV_Neut.fbx 
 
Crouch_Idle 
A_POLY_BOW_Crouch_Idle_BowDown_Neut.fbx 
A_POLY_BOW_Crouch_Idle_BowDown_Reload_Neut.fbx 
A_POLY_BOW_Crouch_Idle_BowDown_Stow_ToBase_Femn.fbx 
A_POLY_BOW_Crouch_Idle_BowDown_Stow_ToBase_Masc.fbx 
A_POLY_BOW_Crouch_Idle_BowDown_ToAiming_Neut.fbx 
 
A_POLY_BOW_Crouch_Idle_BowDown_FPV_Neut.fbx 
A_POLY_BOW_Crouch_Idle_BowDown_Reload_FPV_Neut.fbx 
A_POLY_BOW_Crouch_Idle_BowDown_Stow_ToBase_FPV_Femn.fbx 
A_POLY_BOW_Crouch_Idle_BowDown_Stow_ToBase_FPV_Masc.fbx 
A_POLY_BOW_Crouch_Idle_BowDown_ToAiming_FPV_Neut.fbx 
 
Crouch_Roll 
A_POLY_BOW_Crouch_Idle_BowDown_Roll_F_Neut.fbx 
A_POLY_BOW_Crouch_Idle_BowDown_Roll_F_RM_Neut.fbx 
A_POLY_BOW_Crouch_Idle_BowDown_Roll_L_Neut.fbx 
A_POLY_BOW_Crouch_Idle_BowDown_Roll_L_RM_Neut.fbx 
A_POLY_BOW_Crouch_Idle_BowDown_Roll_R_Neut.fbx 
A_POLY_BOW_Crouch_Idle_BowDown_Roll_R_RM_Neut.fbx 
 
Crouch_Shoot 
A_POLY_BOW_Crouch_Shoot_Reload_Neut.fbx 
A_POLY_BOW_Crouch_Shoot_ToAiming_Neut.fbx 
A_POLY_BOW_Crouch_Shoot_ToIdle_Neut.fbx 
A_POLY_BOW_Crouch_Shoot_Reload_FPV_Neut.fbx 
A_POLY_BOW_Crouch_Shoot_ToAiming_FPV_Neut.fbx 
A_POLY_BOW_Crouch_Shoot_ToIdle_FPV_Neut.fbx 
 
Stand_Aim 
A_POLY_BOW_Stand_Aiming_DrawnShaking_Neut.fbx 
A_POLY_BOW_Stand_Aiming_Drawn_Neut.fbx 
A_POLY_BOW_Stand_Aiming_Reload_Neut.fbx 
A_POLY_BOW_Stand_Aiming_ToDrawn_Neut.fbx 
A_POLY_BOW_Stand_Aiming_Undrawn_Neut.fbx 
 
Stand_Idle_BowDown 
A_POLY_BOW_Stand_Idle_BowDown_Neut.fbx 
A_POLY_BOW_Stand_Idle_BowDown_Reload_Neut.fbx 
A_POLY_BOW_Stand_Idle_BowDown_Stow_ToBase_Femn.fbx 
A_POLY_BOW_Stand_Idle_BowDown_Stow_ToBase_Masc.fbx 
A_POLY_BOW_Stand_Idle_BowDown_Stow_ToTurned_Neut.fbx 
A_POLY_BOW_Stand_Idle_BowDown_ToAiming_Neut.fbx 
A_POLY_BOW_Stand_Idle_BowDown_ToBase_Femn.fbx 
A_POLY_BOW_Stand_Idle_BowDown_ToBase_Masc.fbx 
A_POLY_BOW_Stand_Idle_BowDown_FPV_Neut.fbx 
A_POLY_BOW_Stand_Idle_BowDown_Reload_FPV_Neut.fbx 
A_POLY_BOW_Stand_Idle_BowDown_Stow_ToBase_FPV_Femn.fbx 
A_POLY_BOW_Stand_Idle_BowDown_Stow_ToBase_FPV_Masc.fbx 
A_POLY_BOW_Stand_Idle_BowDown_Stow_ToTurned_FPV_Neut.fbx 
A_POLY_BOW_Stand_Idle_BowDown_ToAiming_FPV_Neut.fbx 
 
Stand_Idle_Turned 
A_POLY_BOW_Stand_Idle_Turned_Equip_ToBowDown_Neut.fbx 
A_POLY_BOW_Stand_Idle_Turned_Neut.fbx 
A_POLY_BOW_Stand_Idle_Turned_ToBase_Femn.fbx 
A_POLY_BOW_Stand_Idle_Turned_ToBase_Masc.fbx 
A_POLY_BOW_Stand_Idle_Turned_Equip_ToBowDown_FPV_Neut.fbx 
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A_POLY_BOW_Hit_Shoulder_R_React_Masc.fbx 
A_POLY_BOW_Hit_Shoulder_R_Stagger_Masc.fbx 
A_POLY_BOW_Hit_Shoulder_R_Stagger_RM_Masc.fbx 
 
Idle 
A_POLY_BOW_Crouch_Idle_Base_Equip_ToBowDown_Masc.fbx 
A_POLY_BOW_Crouch_Idle_Base_Masc.fbx 
A_POLY_BOW_Crouch_Idle_Base_ToBowDown_Masc.fbx 
A_POLY_BOW_Crouch_Idle_Base_WithBow_Masc.fbx 
A_POLY_BOW_Stand_Idle_Base_Equip_ToBowDown_Masc.fbx 
A_POLY_BOW_Stand_Idle_Base_Masc.fbx 
A_POLY_BOW_Stand_Idle_Base_ToBowDown_Masc.fbx 
A_POLY_BOW_Stand_Idle_Base_ToTurned_Masc.fbx 
A_POLY_BOW_Stand_Idle_Base_WithBow_Masc.fbx 
A_POLY_BOW_Crouch_Idle_Base_Equip_ToBowDown_FPV_Masc.fbx 
A_POLY_BOW_Stand_Idle_Base_Equip_ToBowDown_FPV_Masc.fbx 
 

Neutral 
Additive 
A_POLY_BOW_Stand_Aiming_Undrawn_Additive_D90_Neut.fbx 
A_POLY_BOW_Stand_Aiming_Undrawn_Additive_L90_Neut.fbx 
A_POLY_BOW_Stand_Aiming_Undrawn_Additive_N_Neut.fbx 
A_POLY_BOW_Stand_Aiming_Undrawn_Additive_R90_Neut.fbx 
A_POLY_BOW_Stand_Aiming_Undrawn_Additive_U90_Neut.fbx 
 
Melee 
A_POLY_BOW_Blocking_Attack_01_Neut.fbx 
A_POLY_BOW_Blocking_Attack_01_RM_Neut.fbx 
A_POLY_BOW_Blocking_Break_Neut.fbx 
A_POLY_BOW_Blocking_Break_RM_Neut.fbx 
A_POLY_BOW_Blocking_Neut.fbx 
A_POLY_BOW_Blocking_Parry_Neut.fbx 
A_POLY_BOW_Blocking_ToBowDown_Neut.fbx 
A_POLY_BOW_BowDown_ToBlocking_Neut.fbx 
 
Kneeling 
A_POLY_BOW_BowDown_ToKneeling_Neut.fbx 
A_POLY_BOW_Kneeling_Aiming_Drawn_Neut.fbx 
A_POLY_BOW_Kneeling_Aiming_Reload_Neut.fbx 
A_POLY_BOW_Kneeling_Aiming_ToDrawn_Neut.fbx 
A_POLY_BOW_Kneeling_Aiming_Undrawn_Neut.fbx 
A_POLY_BOW_Kneeling_ToBowDown_Neut.fbx 
A_POLY_BOW_Kneeling_Shoot_Reload_Neut.fbx 
A_POLY_BOW_Kneeling_Shoot_ToAiming_Neut.fbx 

Stand_Shoot 
A_POLY_BOW_Stand_Shoot_Dive_L_ToCrouch_BowDown_Neut.fbx 
A_POLY_BOW_Stand_Shoot_Dive_L_ToCrouch_BowDown_RMH_Neut.fbx 
A_POLY_BOW_Stand_Shoot_Dive_L_ToCrouch_BowDown_RMV_Neut.fbx 
A_POLY_BOW_Stand_Shoot_Dive_L_ToCrouch_BowDown_RM_Neut.fbx 
A_POLY_BOW_Stand_Shoot_Dive_R_ToCrouch_BowDown_Neut.fbx 
A_POLY_BOW_Stand_Shoot_Dive_R_ToCrouch_BowDown_RMH_Neut.fbx 
A_POLY_BOW_Stand_Shoot_Dive_R_ToCrouch_BowDown_RMV_Neut.fbx 
A_POLY_BOW_Stand_Shoot_Dive_R_ToCrouch_BowDown_RM_Neut.fbx 
A_POLY_BOW_Stand_Shoot_Leaping_Neut.fbx 
A_POLY_BOW_Stand_Shoot_Leaping_RMH_Neut.fbx 
A_POLY_BOW_Stand_Shoot_Leaping_RMV_Neut.fbx 
A_POLY_BOW_Stand_Shoot_Leaping_RM_Neut.fbx 
A_POLY_BOW_Stand_Shoot_Reload_Neut.fbx 
A_POLY_BOW_Stand_Shoot_ToAiming_Neut.fbx 
A_POLY_BOW_Stand_Shoot_ToBowDown_Neut.fbx 
LeanBack 
A_POLY_BOW_Idle_BowDown_ToLeanBack_Neut.fbx 
A_POLY_BOW_LeanBack_Aiming_Drawn_Neut.fbx 
A_POLY_BOW_LeanBack_Aiming_Reload_Neut.fbx 
A_POLY_BOW_LeanBack_Aiming_ToDrawn_Neut.fbx 
A_POLY_BOW_LeanBack_Aiming_Undrawn_Neut.fbx 
A_POLY_BOW_LeanBack_ToBowDown_Neut.fbxt 
A_POLY_BOW_LeanBack_Shoot_Reload_Neut.fbx 
A_POLY_BOW_LeanBack_Shoot_ToAiming_Neut.fbx 
 
Sliding 
A_POLY_BOW_Run_ToSliding_Aiming_Neut.fbx 
A_POLY_BOW_Run_ToSliding_Aiming_RM_Neut.fbx 
A_POLY_BOW_Sliding_Aiming_Drawn_Neut.fbx 
A_POLY_BOW_Sliding_Aiming_Drawn_RM_Neut.fbx 
A_POLY_BOW_Sliding_Aiming_Reload_Neut.fbx 
A_POLY_BOW_Sliding_Aiming_Reload_RM_Neut.fbx 
A_POLY_BOW_Sliding_Aiming_ToDrawn_Neut.fbx 
A_POLY_BOW_Sliding_Aiming_ToDrawn_RM_Neut.fbx 
A_POLY_BOW_Sliding_Aiming_Undrawn_Neut.fbx 
A_POLY_BOW_Sliding_Aiming_Undrawn_RM_Neut.fbx 
A_POLY_BOW_Sliding_ToIdle_Crouch_Neut.fbx 
A_POLY_BOW_Sliding_ToIdle_Crouch_RM_Neut.fbx 
A_POLY_BOW_Sliding_Shoot_Reload_Neut.fbx 
A_POLY_BOW_Sliding_Shoot_Reload_RM_Neut.fbx 
A_POLY_BOW_Sliding_Shoot_ToAiming_Neut.fbx 
A_POLY_BOW_Sliding_Shoot_ToAiming_RM_Neut.fbx 
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List of Sidekick Character Animations 

Feminine 
Death 
A_MOD_BOW_Death_Head_F_Femn.fbx 
A_MOD_BOW_Death_Head_L_Femn.fbx 
A_MOD_BOW_Death_Head_R_Femn.fbx 
A_MOD_BOW_Death_Spine_B_Femn.fbx 
A_MOD_BOW_Death_Stomach_F_Femn.fbx 
 
Hit 
A_MOD_BOW_Hit_Back_B_React_Femn.fbx 
A_MOD_BOW_Hit_Back_B_Stagger_Femn.fbx 
A_MOD_BOW_Hit_Back_B_Stagger_RM_Femn.fbx 
A_MOD_BOW_Hit_Head_B_React_Femn.fbx 
A_MOD_BOW_Hit_Head_B_Stagger_Femn.fbx 
A_MOD_BOW_Hit_Head_B_Stagger_RM_Femn.fbx 
A_MOD_BOW_Hit_Head_F_React_Femn.fbx 
A_MOD_BOW_Hit_Head_F_Stagger_Femn.fbx 
A_MOD_BOW_Hit_Head_F_Stagger_RM_Femn.fbx 
A_MOD_BOW_Hit_Head_L_React_Femn.fbx 
A_MOD_BOW_Hit_Head_L_Stagger_Femn.fbx 
A_MOD_BOW_Hit_Head_L_Stagger_RM_Femn.fbx 
A_MOD_BOW_Hit_Head_R_React_Femn.fbx 
A_MOD_BOW_Hit_Head_R_Stagger_Femn.fbx 
A_MOD_BOW_Hit_Head_R_Stagger_RM_Femn.fbx 
A_MOD_BOW_Hit_Shoulder_L_React_Femn.fbx 
A_MOD_BOW_Hit_Shoulder_L_Stagger_Femn.fbx 
A_MOD_BOW_Hit_Shoulder_L_Stagger_RM_Femn.fbx 
A_MOD_BOW_Hit_Shoulder_R_React_Femn.fbx 
A_MOD_BOW_Hit_Shoulder_R_Stagger_Femn.fbx 
A_MOD_BOW_Hit_Shoulder_R_Stagger_RM_Femn.fbx 
 
Idle 
A_MOD_BOW_Crouch_Idle_Base_Equip_ToBowDown_Femn.fbx 
A_MOD_BOW_Crouch_Idle_Base_Femn.fbx 
A_MOD_BOW_Crouch_Idle_Base_ToBowDown_Femn.fbx 
A_MOD_BOW_Crouch_Idle_Base_WithBow_Femn.fbx 
A_MOD_BOW_Stand_Idle_Base_Equip_ToBowDown_Femn.fbx 
A_MOD_BOW_Stand_Idle_Base_Femn.fbx 
A_MOD_BOW_Stand_Idle_Base_ToBowDown_Femn.fbx 
A_MOD_BOW_Stand_Idle_Base_ToTurned_Femn.fbx 
A_MOD_BOW_Stand_Idle_Base_WithBow_Femn.fbx 
A_MOD_BOW_Crouch_Idle_Base_Equip_ToBowDown_FPV_Femn.fbx 
A_MOD_BOW_Stand_Idle_Base_Equip_ToBowDown_FPV_Femn.fbx 
 

Masculine 
Death 
A_MOD_BOW_Death_Head_F_Masc.fbx 
A_MOD_BOW_Death_Head_L_Masc.fbx 
A_MOD_BOW_Death_Head_R_Masc.fbx 
A_MOD_BOW_Death_Spine_B_Masc.fbx 
A_MOD_BOW_Death_Stomach_F_Masc.fbx 
 
Hit 
A_MOD_BOW_Hit_Back_B_React_Masc.fbx 
A_MOD_BOW_Hit_Back_B_Stagger_Masc.fbx 
A_MOD_BOW_Hit_Back_B_Stagger_RM_Masc.fbx 
A_MOD_BOW_Hit_Head_B_React_Masc.fbx 
A_MOD_BOW_Hit_Head_B_Stagger_Masc.fbx 
A_MOD_BOW_Hit_Head_B_Stagger_RM_Masc.fbx 
A_MOD_BOW_Hit_Head_F_React_Masc.fbx 
A_MOD_BOW_Hit_Head_F_Stagger_Masc.fbx 
A_MOD_BOW_Hit_Head_F_Stagger_RM_Masc.fbx 
A_MOD_BOW_Hit_Head_L_React_Masc.fbx 
A_MOD_BOW_Hit_Head_L_Stagger_Masc.fbx 
A_MOD_BOW_Hit_Head_L_Stagger_RM_Masc.fbx 
A_MOD_BOW_Hit_Head_R_React_Masc.fbx 
A_MOD_BOW_Hit_Head_R_Stagger_Masc.fbx 
A_MOD_BOW_Hit_Head_R_Stagger_RM_Masc.fbx 
A_MOD_BOW_Hit_Shoulder_L_React_Masc.fbx 
A_MOD_BOW_Hit_Shoulder_L_Stagger_Masc.fbx 

Neutral 

Crouch_Aim 
A_MOD_BOW_Crouch_Aiming_DrawnShaking_Neut.fbx 
A_MOD_BOW_Crouch_Aiming_Drawn_Neut.fbx 
A_MOD_BOW_Crouch_Aiming_Reload_Neut.fbx 
A_MOD_BOW_Crouch_Aiming_ToDrawn_Neut.fbx 
A_MOD_BOW_Crouch_Aiming_Undrawn_Neut.fbx 
A_MOD_BOW_Crouch_Aiming_DrawnShaking_FPV_Neut.fbx 
A_MOD_BOW_Crouch_Aiming_Drawn_FPV_Neut.fbx 
A_MOD_BOW_Crouch_Aiming_Reload_FPV_Neut.fbx 
A_MOD_BOW_Crouch_Aiming_ToDrawn_FPV_Neut.fbx 
A_MOD_BOW_Crouch_Aiming_Undrawn_FPV_Neut.fbx 
 
Crouch_Idle 
A_MOD_BOW_Crouch_Idle_BowDown_Neut.fbx 
A_MOD_BOW_Crouch_Idle_BowDown_Reload_Neut.fbx 
A_MOD_BOW_Crouch_Idle_BowDown_Stow_ToBase_Femn.fbx 
A_MOD_BOW_Crouch_Idle_BowDown_Stow_ToBase_Masc.fbx 
A_MOD_BOW_Crouch_Idle_BowDown_ToAiming_Neut.fbx 
 
A_MOD_BOW_Crouch_Idle_BowDown_FPV_Neut.fbx 
A_MOD_BOW_Crouch_Idle_BowDown_Reload_FPV_Neut.fbx 
A_MOD_BOW_Crouch_Idle_BowDown_Stow_ToBase_FPV_Femn.fbx 
A_MOD_BOW_Crouch_Idle_BowDown_Stow_ToBase_FPV_Masc.fbx 
A_MOD_BOW_Crouch_Idle_BowDown_ToAiming_FPV_Neut.fbx 
 
Crouch_Roll 
A_MOD_BOW_Crouch_Idle_BowDown_Roll_F_Neut.fbx 
A_MOD_BOW_Crouch_Idle_BowDown_Roll_F_RM_Neut.fbx 
A_MOD_BOW_Crouch_Idle_BowDown_Roll_L_Neut.fbx 
A_MOD_BOW_Crouch_Idle_BowDown_Roll_L_RM_Neut.fbx 
A_MOD_BOW_Crouch_Idle_BowDown_Roll_R_Neut.fbx 
A_MOD_BOW_Crouch_Idle_BowDown_Roll_R_RM_Neut.fbx 
 
Crouch_Shoot 
A_MOD_BOW_Crouch_Shoot_Reload_Neut.fbx 
A_MOD_BOW_Crouch_Shoot_ToAiming_Neut.fbx 
A_MOD_BOW_Crouch_Shoot_ToIdle_Neut.fbx 
A_MOD_BOW_Crouch_Shoot_Reload_FPV_Neut.fbx 
A_MOD_BOW_Crouch_Shoot_ToAiming_FPV_Neut.fbx 
A_MOD_BOW_Crouch_Shoot_ToIdle_FPV_Neut.fbx 
 
Stand_Aim 
A_MOD_BOW_Stand_Aiming_DrawnShaking_Neut.fbx 
A_MOD_BOW_Stand_Aiming_Drawn_Neut.fbx 
A_MOD_BOW_Stand_Aiming_Reload_Neut.fbx 
A_MOD_BOW_Stand_Aiming_ToDrawn_Neut.fbx 
A_MOD_BOW_Stand_Aiming_Undrawn_Neut.fbx 
 
Stand_Idle_BowDown 
A_MOD_BOW_Stand_Idle_BowDown_Neut.fbx 
A_MOD_BOW_Stand_Idle_BowDown_Reload_Neut.fbx 
A_MOD_BOW_Stand_Idle_BowDown_Stow_ToBase_Femn.fbx 
A_MOD_BOW_Stand_Idle_BowDown_Stow_ToBase_Masc.fbx 
A_MOD_BOW_Stand_Idle_BowDown_Stow_ToTurned_Neut.fbx 
A_MOD_BOW_Stand_Idle_BowDown_ToAiming_Neut.fbx 
A_MOD_BOW_Stand_Idle_BowDown_ToBase_Femn.fbx 
A_MOD_BOW_Stand_Idle_BowDown_ToBase_Masc.fbx 
A_MOD_BOW_Stand_Idle_BowDown_FPV_Neut.fbx 
A_MOD_BOW_Stand_Idle_BowDown_Reload_FPV_Neut.fbx 
A_MOD_BOW_Stand_Idle_BowDown_Stow_ToBase_FPV_Femn.fbx 
A_MOD_BOW_Stand_Idle_BowDown_Stow_ToBase_FPV_Masc.fbx 
A_MOD_BOW_Stand_Idle_BowDown_Stow_ToTurned_FPV_Neut.fbx 
A_MOD_BOW_Stand_Idle_BowDown_ToAiming_FPV_Neut.fbx 
 
Stand_Idle_Turned 
A_MOD_BOW_Stand_Idle_Turned_Equip_ToBowDown_Neut.fbx 
A_MOD_BOW_Stand_Idle_Turned_Neut.fbx 
A_MOD_BOW_Stand_Idle_Turned_ToBase_Femn.fbx 
A_MOD_BOW_Stand_Idle_Turned_ToBase_Masc.fbx 
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A_MOD_BOW_Hit_Shoulder_L_Stagger_RM_Masc.fbx 
A_MOD_BOW_Hit_Shoulder_R_React_Masc.fbx 
A_MOD_BOW_Hit_Shoulder_R_Stagger_Masc.fbx 
A_MOD_BOW_Hit_Shoulder_R_Stagger_RM_Masc.fbx 
 
Idle 
A_MOD_BOW_Crouch_Idle_Base_Equip_ToBowDown_Masc.fbx 
A_MOD_BOW_Crouch_Idle_Base_Masc.fbx 
A_MOD_BOW_Crouch_Idle_Base_ToBowDown_Masc.fbx 
A_MOD_BOW_Crouch_Idle_Base_WithBow_Masc.fbx 
A_MOD_BOW_Stand_Idle_Base_Equip_ToBowDown_Masc.fbx 
A_MOD_BOW_Stand_Idle_Base_Masc.fbx 
A_MOD_BOW_Stand_Idle_Base_ToBowDown_Masc.fbx 
A_MOD_BOW_Stand_Idle_Base_ToTurned_Masc.fbx 
A_MOD_BOW_Stand_Idle_Base_WithBow_Masc.fbx 
A_MOD_BOW_Crouch_Idle_Base_Equip_ToBowDown_FPV_Masc.fbx 
A_MOD_BOW_Stand_Idle_Base_Equip_ToBowDown_FPV_Masc.fbx 
 

Neutral 
Additive 
A_MOD_BOW_Stand_Aiming_Undrawn_Additive_D90_Neut.fbx 
A_MOD_BOW_Stand_Aiming_Undrawn_Additive_L90_Neut.fbx 
A_MOD_BOW_Stand_Aiming_Undrawn_Additive_N_Neut.fbx 
A_MOD_BOW_Stand_Aiming_Undrawn_Additive_R90_Neut.fbx 
A_MOD_BOW_Stand_Aiming_Undrawn_Additive_U90_Neut.fbx 
 
Melee 
A_MOD_BOW_Blocking_Attack_01_Neut.fbx 
A_MOD_BOW_Blocking_Attack_01_RM_Neut.fbx 
A_MOD_BOW_Blocking_Break_Neut.fbx 
A_MOD_BOW_Blocking_Break_RM_Neut.fbx 
A_MOD_BOW_Blocking_Neut.fbx 
A_MOD_BOW_Blocking_Parry_Neut.fbx 
A_MOD_BOW_Blocking_ToBowDown_Neut.fbx 
A_MOD_BOW_BowDown_ToBlocking_Neut.fbx 
 
Kneeling 
A_MOD_BOW_BowDown_ToKneeling_Neut.fbx 
A_MOD_BOW_Kneeling_Aiming_Drawn_Neut.fbx 
A_MOD_BOW_Kneeling_Aiming_Reload_Neut.fbx 
A_MOD_BOW_Kneeling_Aiming_ToDrawn_Neut.fbx 
A_MOD_BOW_Kneeling_Aiming_Undrawn_Neut.fbx 
A_MOD_BOW_Kneeling_ToBowDown_Neut.fbx 
A_MOD_BOW_Kneeling_Shoot_Reload_Neut.fbx 
A_MOD_BOW_Kneeling_Shoot_ToAiming_Neut.fbx 

A_MOD_BOW_Stand_Idle_Turned_Equip_ToBowDown_FPV_Neut.fbx 
 
Stand_Shoot 
A_MOD_BOW_Stand_Shoot_Dive_L_ToCrouch_BowDown_Neut.fbx 
A_MOD_BOW_Stand_Shoot_Dive_L_ToCrouch_BowDown_RMH_Neut.fbx 
A_MOD_BOW_Stand_Shoot_Dive_L_ToCrouch_BowDown_RMV_Neut.fbx 
A_MOD_BOW_Stand_Shoot_Dive_L_ToCrouch_BowDown_RM_Neut.fbx 
A_MOD_BOW_Stand_Shoot_Dive_R_ToCrouch_BowDown_Neut.fbx 
A_MOD_BOW_Stand_Shoot_Dive_R_ToCrouch_BowDown_RMH_Neut.fbx 
A_MOD_BOW_Stand_Shoot_Dive_R_ToCrouch_BowDown_RMV_Neut.fbx 
A_MOD_BOW_Stand_Shoot_Dive_R_ToCrouch_BowDown_RM_Neut.fbx 
A_MOD_BOW_Stand_Shoot_Leaping_Neut.fbx 
A_MOD_BOW_Stand_Shoot_Leaping_RMH_Neut.fbx 
A_MOD_BOW_Stand_Shoot_Leaping_RMV_Neut.fbx 
A_MOD_BOW_Stand_Shoot_Leaping_RM_Neut.fbx 
A_MOD_BOW_Stand_Shoot_Reload_Neut.fbx 
A_MOD_BOW_Stand_Shoot_ToAiming_Neut.fbx 
A_MOD_BOW_Stand_Shoot_ToBowDown_Neut.fbx 
LeanBack 
A_MOD_BOW_Idle_BowDown_ToLeanBack_Neut.fbx 
A_MOD_BOW_LeanBack_Aiming_Drawn_Neut.fbx 
A_MOD_BOW_LeanBack_Aiming_Reload_Neut.fbx 
A_MOD_BOW_LeanBack_Aiming_ToDrawn_Neut.fbx 
A_MOD_BOW_LeanBack_Aiming_Undrawn_Neut.fbx 
A_MOD_BOW_LeanBack_ToBowDown_Neut.fbxt 
A_MOD_BOW_LeanBack_Shoot_Reload_Neut.fbx 
A_MOD_BOW_LeanBack_Shoot_ToAiming_Neut.fbx 
 
Sliding 
A_MOD_BOW_Run_ToSliding_Aiming_Neut.fbx 
A_MOD_BOW_Run_ToSliding_Aiming_RM_Neut.fbx 
A_MOD_BOW_Sliding_Aiming_Drawn_Neut.fbx 
A_MOD_BOW_Sliding_Aiming_Drawn_RM_Neut.fbx 
A_MOD_BOW_Sliding_Aiming_Reload_Neut.fbx 
A_MOD_BOW_Sliding_Aiming_Reload_RM_Neut.fbx 
A_MOD_BOW_Sliding_Aiming_ToDrawn_Neut.fbx 
A_MOD_BOW_Sliding_Aiming_ToDrawn_RM_Neut.fbx 
A_MOD_BOW_Sliding_Aiming_Undrawn_Neut.fbxIdle 
A_MOD_BOW_Sliding_Aiming_Undrawn_RM_Neut.fbx 
A_MOD_BOW_Sliding_ToIdle_Crouch_Neut.fbx 
A_MOD_BOW_Sliding_ToIdle_Crouch_RM_Neut.fbx 
A_MOD_BOW_Sliding_Shoot_Reload_Neut.fbx 
A_MOD_BOW_Sliding_Shoot_Reload_RM_Neut.fbx 
A_MOD_BOW_Sliding_Shoot_ToAiming_Neut.fbx 
A_MOD_BOW_Sliding_Shoot_ToAiming_RM_Neut.fbx 
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Sidekick and Polygon Animations 

The BowCombat pack is designed to work with two main Synty character types: 
Polygon and Sidekick.  

These two character types have different skeletons and proportions, so the 
BowCombat animation pack has been adapted for both character types via 
two different sets of animations, for maximum compatibility.  

Any animations with the prefix ‘_MOD_’ are designed for use with Synty Sidekick 
characters, whereas animations with the prefix ‘_POLY_’ are designed for use 
with Synty Polygon characters. The animations are split into respective Sidekick 
and Polygon folders under:  

Assets/Synty/AnimationGoblinLocomotion/Animation/

 

Masculine and Feminine Animations 

The BowCombat pack includes animation subsets with different posing styles to 
offer masculine and feminine variations, giving users a broader range of 
character expression options. 

●​ Animations with the suffix '_Femn' use more feminine posing 
●​ Animations with the suffix '_Masc' use more masculine posing 
●​ Otherwise, animations end with the suffix '_Neut'  
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Many animations in the BowCombat pack (including hits, deaths, equipping, 
stowing) are available in both masculine and feminine versions. This provides 
seamless integration with other Synty packs that use the same 
'Idle_Base_Masc' and 'Idle_Base_Femn' base poses. 

Masculine, Feminine, and Neutral animations are organized in their respective 
folders 

Example path: ​
Assets\Synty\AnimationBowCombat\Animations\Sidekick\Masculine\ 

 

4.​ Prop Bone 

To enable more natural prop motion and flexibility in prop behavior, new Prop_L 
and Prop_R bones have been added to the Synty Polygon character beneath 
the Hand_L and Hand_R bones, respectively. 

These additions allow for different hand grips where props can be oriented 
uniquely relative to the hand: 

 

The Sidekick character in this pack also includes prop joints, as well as 
additional bones such as ‘twist’ joints in the limbs and ‘attach’ joints. 

By default, Unity’s Humanoid Avatar system does not recognize extra bones 
during animation playback. As a result, animation assets won’t animate these 
bones unless they have an assigned AvatarMask that explicitly includes them. 
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To address this, the pack includes AvatarMask assets with the extra joints 
enabled. The included animations are configured to use the appropriate 
(Polygon or Sidekick) mask, ensuring proper playback of keyframed motion on 
these extra bones. 

For this reason, animation clips in this pack use the AvatarMask assets:  

Mask_PolygonSyntyCharacter​
Mask_SidekickSyntyCharacter 

These are located here: 

/Assets/Synty/AnimationBowCombat/Samples/Meshes/ 

 

Prop Bone Binder Tool 

For skeletal meshes that do not include a prop bone (e.g. older Synty 
characters, or non-Synty characters), the BowCombat pack comes with a tool 
to add ‘virtual’ prop bones to any character so the bow animation can still be 
correctly played.  
 
The virtual prop bone binder tool works with the standard POLYGON character 
Rig, POLYGON Kid Rig, POLYGON Big Rig. Demonstrations of these characters and 
how they are set up can be found in the ANIMATION BowCombat gallery scene. 
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Setting up your character 

Setting up your character only involves a couple of steps: 
1.​ Select your character. Select either an instance in the scene or an open 

prefab.  
2.​ Use the menu item Synty > Tools > Animation > Setup Prop Bones 
3.​ Attach your weapon to the newly created Prop_L_Socket game object 

located under Hand_L in the skeleton. 

 
 
That’s it! 
 
Tip: To update multiple characters at once drag them all into the scene, select 
their root nodes and run the tool. 
 
After following the steps above you should see the Prop Bone Binder component 
on the game object that your character’s Animator component is on. The green 
status message denotes that the character is correctly configured for the 
animations to work. 
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​
 
You will find a PropBoneBindingConfig file in your project. This file details the 
location of the prop bone and the offset orientation and scale between your 
character’s rig and the ANIMATION BowCombat rig. 

 
 
The offset values are calculated automatically on set up but if needed you can 
edit these values manually when setting up your own custom rigs. 
 
To calculate the values automatically make sure: 

1.​ Set the source rig and target rig references 
2.​ Make sure the source rig and target rig are in T Pose 
3.​ Set names of all the bones in the Prop Bone Definitions list 
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4.​ Click the Calculate Bone Offset Values button 
 
Source Rig: The rig the animations are keyed for. In this case it should be the 
ANIMATION Bow Combat Rig (PolygonSyntyCharacter) 
Target Rig: The rig that you intend to play the animations on. This is your game’s 
character model or prefab. 
Parent Bone Name: The bone to create the virtual prop bone under. 
Bone Name: The name of the virtual prop bone. The tool will generate this node. 
Socket Name: The name of the object to attach your props to. The tool will 
generate this node. 
Rotation Offset: Rotation offset used to compensate for differences in 
orientation of the parent bone between the source rig and the target rig 
Scalar: Value used to compensate for differences in size between the source rig 
and the target rig. A value of 1 = target rig is the same scale as the reference 
rig, a value of 2 = target rig is twice the size as the reference rig. 
Scale Calculation Bone 1 / Scale Calculation Bone 2: The bones used to 
determine the difference in size between the source rig and the target rig. 
These bones need to exist in both rigs for the automatic calculation of Scalar to 
work. 
 

Prop Bone Binder Tool Troubleshooting 
My weapon is not oriented correctly 

●​ There could be a couple of reasons for this: 
a.​ You need to find the correct orientation to attach your weapon to 

the Prop_L_Socket game object. The weapons that come with the 
BowCombat pack are designed to be attached with 0,0,0 rotation. 
You can use this bow as a guide to ensure you’ve attached your 
weapon in the correct orientation. 

b.​ The values in the Prop Bone Binding Config file are not set up 
correctly. POLYGON rigs should be set up correctly by default but 
these values can be manually set if need be. 

 
The status does not say “This character has been set up”: 

●​ There are many reasons why a character may not be set up correctly. Try 
clicking the One click setup button and see if that resolves the issue, if not 
check the console for more details about what could have gone wrong. 
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I have a few different character rigs in my game. Does the tool work in this 
case? 

●​ Yes! You will need a Prop Bone Binding Config file for each rig you are 
using. Additionally, ensure that each character references the correct 
config file. The tool should automatically set up the characters and create 
new config files when it needs to. Simply select all your characters and 
use the menu options Synty/Tools/Animation/Setup Prop Bones 

 

Removing the Prop Bone Binder Tool 
You may find you need to remove the bones created by the Prop Bone Binding 
Tool. The tool provides you with the ability to do this. Located on the Prop Bone 
Binder component, under More Options is the Reset button. Click Reset and all 
objects created by the tool will be destroyed. Any props attached to the socket 
will be reparented to the Hand bone. After successfully removing the bones you 
can remove the Prop Bone Binder component from your character. 

Prop Bone with Non-POLYGON Rigs 
For the prop bone to animate the hierarchy paths needs to be a match for the 
animation property. For example - The Prop_R path is:​
 
Root/Hips/Spine_01/Spine_02/Spine_03/Clavicle_R/Shoulder_R/Elbow_R/Hand_R/Pro
p_R​
 
If your rig is not named like this then it will not animate even with the virtual prop 
bone added. 

Using Animations Without Prop Bones 
It is possible to simply parent a weapon to the Hand bone and to use this 
animation set on any Humanoid Unity character, however it is recommended to 
use a Synty character with the extra prop bone to take advantage of the fluid 
prop animations. Some animations in particular (where the prop moves) will not 
look correct without the prop parented to the animated Prop bone.  
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5.​ Weapon/Prop Animation 

Since the bow is not a static weapon, the bows in this pack are rigged and 
designed to be animated. Any character animation in the BowCombat pack 
that includes a bow will have an associated Prop animation file, intended to be 
played on the weapon in sync with the character animation. 

There are three types of Prop animations in this pack, each corresponding to a 
different bow type: Longbow, Recurve, and Compound. 

The basic setup is as follows: a rigged bow asset should be placed under the 
‘Prop_L’ bone in the character hierarchy, and an arrow (if needed) should be 
placed under the ‘arrow_rest_jnt’ bone on the bow rig. 

Then the character animation and the corresponding bow animation should be 
played synchronously to ensure the animation displays correctly. 

 

Example Setup 

In this example, we’ll play a shooting Sidekick animation using Unity’s Timeline. 

Make sure you have the Timeline package installed: 

Go to Window > Package Manager, scroll down to Timeline, and click Install if 
it’s not already enabled.​

 

1. Add the Character 
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Drag a SidekickSyntyCharacter asset into your scene from the following folder:​
 Assets/Synty/AnimationBowCombat/Samples/Meshes/ 

2. Equip the Bow 

Equip the desired weapon to the character’s prop_l bone. The exact hierarchy 
location matters, as it ensures the bow inherits the correct position to inherit 
prop animation. 

In this example, we’ll use the Compound Bow asset Wep_CompoundBow_01.​
 Drag it from this directory: 

Assets/Synty/AnimationBowCombat/Prefabs/Bows/Compound/ 

Then make it a child of the character’s prop_l bone. 

 

Ensure that the transform values of the Wep_CompoundBow_01 prefab are set 
to 0, as this will ensure the bow plays its animation in the correct spot with no 
offsets. 
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3. Add the Arrow 

An arrow asset should also be added for the shot. There are two valid locations 
to attach it: 

●​ The bow’s arrow_rest_jnt bone 
●​ The character’s prop_r bone 

In this example, we’ll attach the arrow to the bow.​
Expand the Compound Bow prefab hierarchy until you find arrow_rest_jnt.​
Then drag in an arrow prefab such as Wep_Arrow_Modern_01 from: 

Assets/Synty/AnimationBowCombat/Prefabs/Arrows/ 

Make it a child of arrow_rest_jnt, and again, set its Transform values to zero. 

 

4. Set Up the Timeline 

The setup of props is complete. Now to add some animation using a Timeline.  

Create an empty GameObject in the scene and name it (e.g. TimelineObj).​
Add a Playable Director component to it. 
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Create a new Timeline asset and assign it to the Playable field of the Playable 
Director. 

 

Then open the Timeline window:  Window > Sequencing > Timeline. 
 
Select TimelineObj - you should see a blank timeline ready to use. 

5. Add Animation Tracks 

Drag both the SidekickSyntyCharacter and the Wep_CompoundBow_01 
prefab into the Timeline window.​
 When prompted, choose Add Animation Track for each.​
 You should now have two animation tracks, one for the character and one for 
the bow. 
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6. Add the Animation Clips 

Locate the character animation clip. Be sure to use the correct Sidekick 
animation (not from the Polygon folder).​
 For this example, we’ll use: 

A_MOD_BOW_Stand_Shoot_Reload_Neut​
 ​
Located at:​
 Assets/Synty/AnimationBowCombat/Animations/Sidekick/Neutral/Standing/Shoot/ 

Drag the correct animation clip (beneath the animation asset) into the 
SidekickSyntyCharacter track on the Timeline. 

 

Now locate the matching Compound Bow Prop animation. These are located in 
the corresponding Cmp/ subfolder: 

Assets/Synty/AnimationBowCombat/Animations/Sidekick/Neutral/Standing/Shoot/​
Cmp/ 

Find the file with the matching name and the Cmp tag in its filename:​
 A_MOD_BOW_Cmp_Stand_Shoot_Reload_Neut 

Drag the correct animation clip from that file into the Wep_CompoundBow_01 
track on the Timeline. 
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The character and prop animation clips should be identical in length. Align 
them precisely in the tracks, and the bow and character animations will be 
perfectly synchronized. 

 

6.​ Quick Start 
Gallery Scenes 

The Animation BowCombat pack comes with Gallery scenes for both Polygon 
and Sidekick Synty characters: 
 
Gallery_Sidekick 
Gallery_Polygon 
 
You will find the scenes in:  
Assets/Synty/AnimationBowCombat/Samples/Scenes 
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These scenes demonstrate the various animations in this pack as a virtual 
gallery/library so users can break down how the animations work in isolation, 
and to understand further how they work in tandem: 

●​ Labelled groups of animations to quickly track down specific animations 
●​ Looped to see timing/length of animation 
●​ Combined with adjacent relevant clips to loop seamlessly on the timline 

 

 

Under the groups DEMO_Animations_Sidekick_Grp or 
DEMO_Animations_Polygon_Grp in the scene hierarchy, you will find category 
groups with all the animations nested below, e.g. Sliding_Grp. subsequently 
contains subcategories of Sliding_Aim_Grp and Sliding_Shoot_Grp. 
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Those groups have a PlayableDirector component, with an assigned Timeline 
asset that demonstrates how the animations cycle or blend (e.g. to and from 
idle). 
 

Build your own 
The following example will walk you through a typical use case of Synty 
Animation BowCombat as a means to guide your experimentation further to 
find your own workflow. This assumes you have installed the pack correctly and 
are starting from a new scene. 
 

Applying Animations to Characters 

In Unity, a developer can import the animation package into a new scene and 
reference the ‘Polygon’ or ‘Sidekick’ SyntyCharacterAvatar to retarget the 
animation to their own character. This character can be a Synty character or a 
completely different biped, however the animations will work the best with Synty 
characters as the animations were created with their proportions in mind. 
 
For this example, the guide will assume you are using the Polygon Avatar. 

​​ Import Characters: 
●​ Import the Animation BowCombat package into the project for access to 
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the animations and the PolygonSyntyCharacterAvatar  
●​ Import your character that will be the target for Synty BowCombat Pack 

animations 
​​  

​​ Create a Humanoid Avatar on new character: 
●​ On the new character, create a new Avatar and configure bone mappings 

 

Creating a new Avatar 

​​Animation Type: 
●​ Navigate to the Inspector window in Unity of the Character. 
●​ Click on the Rig tab to access the Avatar Configuration tab. 

​​Avatar Definition: 
●​ Set the Animation Type to Humanoid  
●​ Set the Avatar Definition to Create From This Model to generate a 

humanoid avatar based on the character's rig. 

​
Modifying existing Avatar 

​​Access Avatar Configuration: 
●​ Click on Configure… to access the Avatar Configuration tab. 

​​Bone Mapping: 
●​ Review and adjust bone mappings to ensure precise alignment with 
the character's skeletal structure. 
●​ NOTE: Synty POLYGON characters have three finger bone chains: the 
Thumb, Index, and a third ‘mitt’ which is a representation of the rest of the 
fingers on the hand. The default setup in Synty POLYGON Animation packs 
is to have the third ‘mitt’ finger mapped to the ‘Middle’ finger.  
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●​ By default, Unity sometimes automatically maps these finger joints 
to the ‘Little’ finger on a new Avatar configuration. This can result in Synty 
POLYGON animations not correctly playing finger animation on such an 
avatar.  
●​ To ensure the correct interpretation of Synty POLYGON animation, 
configure the hands to match the setup displayed below: 

 

​​Preview and Apply: 
●​ Check for any errors that occur or if you are using the same bone in 
two definitions in the skeletal mapping 
●​ Apply changes to update the avatar properties. 
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Now animations from the BowCombat pack can be applied to an Animator or a 
Timeline using the new character, and will retarget automatically due to the 
Humanoid setup.  
 

Integrating Synty Animation BowCombat with Synty Base 
Locomotion 

Animation BowCombat is designed to integrate easily with existing Synty 
animation packages. If you already own Base Locomotion, you can get the 
PF_Player prefab set up to work with BowCombat pack animations. 

1.​ If you are using Base Locomotion version earlier than 1.1.0, you need to 
swap out the character mesh for a newer one that includes prop bones, or 
add a virtual prop bone using the Prop Bone Binder Tool. To use this tool, 
see Section 4 of the guide. guide on the Prop Bone Binder Tool, or replace 
the BaseLocomotion character with the BowCombat pack character 
(which includes the prop bone) using these following steps: 

2.​ Open a scene in a project containing Base Locomotion and import the 
BowCombat package (see Section 1 of this guide). 

3.​ Select the PF_Player object in the scene hierarchy, right-click and choose 
‘Prefab’ > ‘Unpack Completely’ 

4.​ Beneath the PolygonSyntyCharacter node, select and delete the 
PolygonSyntyCharacterMesh and Root nodes.  

 
5.​ Drag a new PolygonSyntyCharacter from the BowCombat pack into the 

scene. 
6.​ Right click on this new prefab and select ‘Prefab’ > ‘Unpack Completely’.   

Copyright © 2024 SYNTY STUDIOS LIMITED. All Rights reserved. 

https://docs.google.com/document/d/15RW5uuyXUXil2XvHCqhhoY4M4gGcUH8dMY5_6jUVKZo/edit#heading=h.8benrtp66rgy
https://docs.google.com/document/d/15RW5uuyXUXil2XvHCqhhoY4M4gGcUH8dMY5_6jUVKZo/edit#heading=h.tyjcwt


 

 
7.​ Now drag the two nodes PolygonSyntyCharacterMesh and Root from the 

new BowCombat pack Prefab into the place of the two deleted nodes 
under the PolygonSyntyCharacter inside PF_Player. You can delete the 
rest of the Animation BowCombat pack prefab’s nodes.  

 
8.​ On the node PolygonSyntyCharacter (below PF_Player), update the 

Avatar on the Animator component to use the PolygonSyntyCharacter 
Avatar from the BowCombat pack.  

 
9.​ From here you can begin to add new functionality to the existing 

controller, e.g. new combat archery states, equipping, shooting, reloading, 
etc 

10.​A good starting point is to add an upper body override layer to the 
Animation Controller. This allows you to apply the BowCombat system to 
the upper half of the character while the lower half continues using the 
BaseLocomotion movement animations. 
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Other possible approaches for this kind of setup include: 

●​ Using two animation override layers:​
 The first layer set to around 90–95% weight allows subtle movement from 
the BaseLocomotion to bleed through, making the character feel less stiff 
than a full 100% upper body override.​
 A second layer at 100% weight, masked to just the arms, ensures that the 
hands remain precisely positioned on the bow.​
 

●​ Using Unity’s Animation Rigging package:​
 Combine aim constraints on the chest, spine, or bow to target specific 
points, allowing the upper body and weapon to track independently from 
the character’s overall orientation. 

 
 

Equipping/Stowing Props   
For animations in the BowCobat pack which involve equipping or stowing the 
bow, it is recommended to either reparent the bow, or use a second bow asset 
(parented beneath the Spine_03 bone, for example) that has its visibility 
toggled during equip and stow moments of its animation.  
 
Because the Prop_L  bone is a child of the Hand_L bone in the arm hierarchy, 
there are some potential issues that can arise when the prop needs to be 
‘detached’ from the arm.  
​
During equip and stow animations, during the moments when the Prop_L bone 
remains fixed to the back, it is effectively counter-animating against its parent 
in order to itself remain still (while the arm moves away from it). This can 
possibly cause motion jitter as it interpolates. 
 
It is thus suggested to switch to a bow asset parented to the character’s spine 
at the moment the prop reaches its intended end position.  
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Multiple setups exists in the Gallery scenes demonstrating the transition from a 
prop parented to the Prop_L bone to a prop parented Spine_03 bone.  
The group timeline on object Standing_Grp | Standing_Idle_Grp in the Gallery 
scenes contains the timeline Timeline_POLY_Demo_Standing_Idle_Neut, 
demonstrating transitions during the various Equip and Stow animations, 
swapping between two bow props using an ‘Activation’ track to hide and 
unhide each prop.  

​
Equally, a visibility toggle achieving the same result could be triggered by an 
Animation Event to work on a controllable player, character etc.   
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7.​ Bow Combat Animations 
Stances 

Combat Stances 

The BowCombat animation pack includes a variety of combat stances from 
which the core archery actions can be performed. These stances are: 

●​ Standing 
●​ Crouching 
●​ LeanBack 
●​ Kneeling 
●​ Sliding 

Each stance includes entry and exit animations, as well as a full set of archery 
actions: drawing, aiming, shooting, and reloading. 

Idle Stances 
The pack also comes with some Idle animations (non-combat stances) that 
help this pack link with existing Synty animations. The main Idle poses here are 
the same as in other Synty packs, allowing for seamless blending to and from 
BowCombat animations: 

●​ Stand_Idle_Base (Masc and Femn) 
●​ Crouch_Idle_Base (Masc and Femn) 

​

In addition to these base Synty poses, the BowCombat pack also has variants of 
these with the hands posed to hold the bow: 

●​ Stand_Idle_Base_WithBow (Masc and Femn) 
●​ Crouch_Idle_Base_WithBow (Masc and Femn) 

​

Lastly, there is a standing stance called Stand_Idle_Turned, which includes 
entry and exit animations to and from the standard Stand_Idle_Base poses. 

●​ Stand_Idle_Turned 
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This stance matches the foot position of Stand_Idle_BowDown, reflecting the 
typical side-on posture of an archer. However, unlike Stand_Idle_BowDown, the 
bow is not yet equipped in this pose. 
This allows for a clean separation between two actions: 

●​ Turning the body into the archer’s stance 
●​ Equipping the bow 

 

Aiming 

Aiming animations come in ‘Drawn’ and ‘Undrawn’ varieties, and these 
animations are loops, allowing for them to cycle as long as needed.  

●​ ‘Undrawn’ is a sort of ‘bow-ready’ stance - aiming but not yet primed to 
fire. 

●​ ‘Drawn’ is the bow aiming under full tension, with the arrow ready to fly 
●​ There is a ‘ToDrawn’ animation to transition from ‘Undrawn’ to ‘Drawn’ 

states. 
 

Shooting 

There are two main shooting animations per stance: 
●​ ‘Shoot_ToAiming’ - basic shot which returns to the ‘Aiming_Undrawn’ 

stance afterwards 
●​ ‘Shoot_Reload’ - quickfire action immediately nocks a new arrow and 

then returns to the ‘Aiming_Undrawn’ stance.  
 
Additionally there are some more bespoke and acrobatic animations shots: 

●​ Dive shot (L and R variants) 
●​ Leaping shot  

 
The arrow position on the bow during shooting animations is largely intended to 
be visible before and up until the moment that the bow shoots. From here it 
would be suggested to have a separate arrow asset that spawns and fires from 
the release point on the bow, controlled either by a separate animation, physics 
forces, etc, so it can travel through the scene no longer parented to the bow.  
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FPV 

Some of the animations in the BowCombat pack have the tag ‘_FPV_’ in their 
name, which stands for ‘First Person View’. 
The posing in these animations has been adjusted so that generally the bow will 
be more visible in frame from a camera parented to the head of the character, 
thus more suited to first-person style projects.  

 

Rolls 

The Crouching stance also has some directional roll animations (with the bow 
equipped) for evasive-style dodge movements. 
 

Melee 

Some melee combat animations have been included for scenarios where a bow 
could be used to block incoming melee attacks. The pack includes animations 
to and from Stand_Idle_BowDown, into a Blocking stance which is a looping 
animation cycle. There is also a Parry, and a Blocking_Break animation which 
returns to Stand_Idle_Bow_Down stance, intended for scenarios where the 
block was unsuccessful or the player ran out of stamina, thus staggers back 
from blocking into a regular stance.  
Finally, a Blocking_Attack animation is included, to allow characters to perform 
a rudimentary melee attack using the bow as a club.  
 

Hits and Deaths 

A variety of directional hits and deaths have been included in the pack to 
account for characters being shot from any angle.  
The ‘React’ hits are smaller reactions to taking damage, the ‘Stagger’ hits are 
more extreme and can displace the character away from the direction they 
were struck (including with RootMotion).  
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These animations all include both a Masculine and Feminine set (starting from 
the generic Synty Base_Masc and Base_Femn Idle pose) to blend with other 
Synty Animation Packs. 
 

File Naming conventions 
A_​ Animation 
AC_​ Animation Controller 
M_​ Material​
PM_​ Physics Material 
SK_​ Skeletal Mesh​
SM_​ Static Mesh 
T_​ Texture 
 

Animation Naming Conventions 

The animations in the BowCombat pack follow this ordered system of tags to 
structure the name of the animation file: 

<Filetype>_<SyntyCharacter>_<AnimationPack>_<Prop>_<PropType>_​

<AnimationType/Stance>_<MainAction>_<SubAction>_<Direction/Section>​

_<RootMotion>_<Gender>    

Examples:  

-​ A_MOD_BOW_Sliding_Shoot_Reload_RM_Neut.fbx 

-​ A_MOD_BOW_Cmp_Sliding_Shoot_Reload_Neut.fbx 
-​ A_MOD_BOW_Death_Head_R_Masc.fbx 
-​ A_POLY_BOW_Stand_Idle_BowDown_Stow_ToBase_Femn.fbx 

Categories:  

●​ Filetype: The broad-scope prefix. Here ‘A’ stands for ‘Animation’ 
●​ SyntyCharacter: Which character this animation is for. ‘MOD’ (short for 

‘Modular’) means this animation is for Sidekick characters. ‘POLY’ is used 
for Polygon characters. 
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●​ AnimationPack: Here ‘BOW’ indicates that the animation belongs to the 
‘Goblin Locomotion’ Pack.  

●​ Prop: Denotes whether this animation is for a prop (if not, it’s for the 
character) 

●​ PropType: The type of prop this animation should be played on (‘Lng’ for 
Longbow, ‘Cmp’ for Compound Bow, and ‘Rcv’ for Recurve Bow) 

●​ AnimationType/Stance: The general stance of the animation (e.g. Stand, 
Crouch) 

●​ MainAction:  The key motion of this animation (e.g. Shoot will mean the 
bow is being fired) 

●​ SubAction: The secondary action of this motion (e.g. Reload would mean 
this shooting animation will reload as part of the same fluid motion) 

●​ Direction/Section: Describes what side something is happening (e.g. L or 
R) or what stance this animation is transitioning to (e.g. ToBowDown, 
ToBase) 

●​ RootMotion: If this is the root-motion version of an animation, it is 
indicated with an extra tag, shortened to  ‘RM’ in the new naming 
convention. ‘Vertical-only’ and ‘Horizontal-only’ root motion is indicated 
with the tag ‘RMV’ or ‘RMH’. 

●​ Gender: Either masculine, (Masc), feminine, (Femn) or neutral, (Neut). 
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8.​ Character Avatar 

Mecanim Humanoid Character Avatar 

​​  

In Unity, the mecanim Humanoid Character Avatar serves as a fundamental 
framework for bipedal character animation. Essentially, an avatar in this context 
is a digital representation of a character's skeletal structure and body 
proportions. To access the avatar of a character you can find the mesh that the 
avatar definition is created from, in the case of the Synty pack, the Avatar is 
nested in Synty/AnimationBowCombat/Samples/Meshes as the 
PolygonSyntyCharacterAvatar. 

Here's a breakdown to clarify its purpose for users:​
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Humanoid Structure: 
●​ Unity's mecanim Humanoid Character Avatar adheres to a bipedal 

structure, aligning with the standard anatomy of human characters. 
Compatibility Across Characters: 

●​ Designed to be universally compatible, the avatar allows users to apply 
animations seamlessly to a variety of humanoid characters, streamlining 
the animation process. 

●​ Other character models on different bipedal rigs can be added to the 
project, with their own Avatar set up to allow the animations from this 
pack and others to be  applied to them, bypassing the issue of 
compatibility. 

Configurable and Adaptable: 
●​ Users can configure their own avatars by adjusting the bone mappings 

and aligning them with Unity's Humanoid Avatar configuration.  

Adjusting Avatar Properties 

In Unity, within the rig tab of an asset you are able to define the skeleton type to 
one of the following, Humanoid, Generic or Legacy. 
​

Humanoid is used when working with humanoid characters. It provides a 
standardized bone structure that makes it easier to work with humanoid 
animations, retargeting, and blending. The Humanoid rig is particularly useful 
when using Unity's Mecanim animation system. 
​​​

Generic is a more flexible option that doesn't adhere to the humanoid bone 
structure. It allows for more custom setups but may not be as compatible with 
certain features like retargeting humanoid animations. 
​​​

Legacy is used for the older animation system in Unity. It's not recommended for 
new projects, as Unity has shifted its focus to Mecanim and the Humanoid rig. 
The content within this pack is set up to be used with the Humanoid skeleton 
type, to leverage the aforementioned retargeting and blending with the 
Mecanim animation system. 
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Optimizing Animation Performance 

Unity has numerous options to help optimize performance when using 
animations. These options are within the animation tab for each FBX animation 
asset. 
 
Animation Compression: 

●​ Utilize Unity's animation compression options. 
●​ Use "Optimal" for keyframe reduction. 
●​ Experiment with different compression ratios to find the right balance 

between performance and quality. 
 
Remove Scale Curves: 

●​ If not needed, consider removing scale curves from animations. 
●​ Scale curves can impact performance, and removing them can 

streamline the animation data. 
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9.​ Terms of use 
The full terms of the End User License Agreement (EULA) apply and can be found 
at https://syntystore.com/pages/end-user-licence-agreement. 
 
This is a summary of the license for the Synty Animation Base Locomotion 
software provided by Synty Studios Limited. This summary is for convenience 
only and is not legally binding.  
 
Key Points 
 

1.​ License Grant: When you purchase an Asset, you are granted a license to 
use the Asset subject to the terms of the EULA. All intellectual property 
rights in the Asset remain with Synty Studios Limited. 

2.​ Use of Asset: You are entitled to incorporate the Asset into Products under 
your direct control, and into promotional materials for those Products. You 
can adapt the Asset for these purposes. 

3.​ Restrictions: There are important restrictions on your use of the Asset. For 
example, you cannot use the Asset for Non-Fungible Tokens (NFTs), in 
Blockchain projects, Metaverse-related content, or with Generative AI 
Programs. You also cannot share or redistribute the Asset outside your 
team. 

4.​ Team Size and Seats: Your license includes a limited number of seats for 
your team. If your team grows, you must purchase additional licenses. 

5.​ Unity Asset Store Purchases: If you have purchased the Asset through the 
Unity Asset Store, the terms of the Unity Asset Store EULA also apply. You 
must consult the Unity Asset Store EULA for the full terms applicable to 
your purchase from the Unity Asset Store. 

6.​ Support and Source Files: Support is provided at our discretion. You must 
not share source files of any Assets outside your team. 

7.​ Termination: Your license can be terminated if you breach the EULA and 
fail to remedy the breach after notice from us. 

8.​ Warranties and Liability: The Assets are provided "as is" without 
warranties of any kind, and our liability is limited. 

 
 
By using this Asset, you agree to be bound by the terms of the EULA. 
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10.​ Glossary​
 
Term Definition & Context 

Avatar Mask An AvatarMask is a Unity asset used to specify which parts of an animated 
character's body are affected by an animation. It allows you to isolate or 
blend animations by masking specific body parts—such as arms, legs, or the 
head—enabling layered animations and more precise control in Mecanim's 
Animator system. Commonly used with animation layers and blend trees. 

Character Avatar In Unity's Mecanim system, the Character Avatar refers to the digital 
representation of a character's skeletal structure, including bone hierarchy 
and rigging. It serves as the foundation for applying animations and 
controlling the character's movements within the game. 

FBX A common 3D file format used for importing and exporting models and 
animations between different software. 

Mecanim Mecanim is Unity's animation system, encompassing the Animation Controller, 
Animator component, and state machine. It provides a visual interface for 
designing complex character animations and facilitates the integration of 
character avatars, animation clips, and  
transitions. 

Playable Director A Playable Director is a Unity component that plays Timeline Assets and other 
Playable content. It binds Timelines to scene objects, controls playback, and 
sequences animations, audio, and events. 

Rigged Asset A 3D model that has a skeleton (rig) for animation. 

Root Motion An animation technique where movement is driven by the animation data 
itself, rather than by code. 

Timeline A Timeline Asset is a Unity asset that stores a sequence of tracks, clips, and 
keyframes used in the Timeline system to create cinematic content, 
cutscenes, scripted events, or complex animations. It acts as a reusable 
container for Timeline data, which can be played and controlled by a Playable 
Director component in the scene. 

 

 

Copyright © 2024 SYNTY STUDIOS LIMITED. All Rights reserved. 


	Bow Combat  
	 
	User Guide 
	 
	1.​Introduction 
	2.​Installation and Setup  
	Requirements 
	Unity Asset Store Installation 
	Synty Store Installation 

	3.​Animation Pack Components 
	Key features 
	Animation formats 
	Animation Sets 
	Models: 
	Humanoid Character Avatar: 
	Gallery Scenes: 

	List of Polygon Character Animations 
	List of Sidekick Character Animations 
	 
	Sidekick and Polygon Animations 
	Masculine and Feminine Animations 

	4.​Prop Bone 
	Prop Bone Binder Tool 
	Setting up your character 
	Prop Bone Binder Tool Troubleshooting 

	Removing the Prop Bone Binder Tool 
	Prop Bone with Non-POLYGON Rigs 
	Using Animations Without Prop Bones 

	5.​Weapon/Prop Animation 
	 
	Example Setup 
	1. Add the Character 
	2. Equip the Bow 
	3. Add the Arrow 
	4. Set Up the Timeline 
	5. Add Animation Tracks 
	6. Add the Animation Clips 


	6.​Quick Start 
	Gallery Scenes 
	Build your own 
	Applying Animations to Characters 
	Creating a new Avatar 
	​Modifying existing Avatar 
	Integrating Synty Animation BowCombat with Synty Base Locomotion 

	Equipping/Stowing Props   

	7.​Bow Combat Animations 
	Stances 
	Combat Stances 
	Idle Stances 

	Aiming 
	Shooting 
	FPV 
	 
	Rolls 
	Melee 
	Hits and Deaths 
	File Naming conventions 
	Animation Naming Conventions 

	8.​Character Avatar 
	Mecanim Humanoid Character Avatar 
	Adjusting Avatar Properties 
	Optimizing Animation Performance 

	9.​Terms of use 
	10.​Glossary​ 
	 

